
Computer Applications 
1. Which pointing device action should you use for selecting objects or commands, opening menus, or 

other items on the taskbar? 

    A. double clicking 

    B. dragging 

    C. clicking 

    D. pointing 

 

2. A file on a computer which tells it how to communicate with an add-on piece of equipment is called 

a(n): 

    A. application 

    B. driver 

    C. installer 

    D. program 

 

3. The general term for stored data such as a computer program is: 

    A. hardware 

    B. RAM 

    C. software 

    D. PROM 

 

4. What is the function key for the help feature found in word processing software packages? 

    A. F7 

    B. F10 

    C. F2 

    D. F1 

 

5. A laser printer would be considered: 

    A. digital 

    B. software 

    C. network 

    D. hardware 

 

6. Software provided at no cost to a user is known as: 

    A. application 

    B. software 

    C. hardware 

    D. freeware 

 

7. What are pictures and words to represent functions called? 

    A. clipart 



    B. graphical user interface 

    C. icons 

    D. word art 

 

8. The performance of a hard drives other storage device. 

    A. access time 

    B. command 

    C. batching 

    D. downtime 

 

9. The _____ is the portion of the computer system that carries out the instructions of a computer 

program and is the primary element carrying out the computer's functions. 

    A. USB 

    B. CPU 

    C. PSU 

    D. Cache 

 

10. The processing of storing a document to retrieve later is called: 

    A. store 

    B. pack 

    C. save 

    D. bundle 

 

11. A program used to view web is: 

    A. Browser 

    B. Search 

    C. Explore 

    D. Filter 

 

12. Formatting professional business documents can include: 

    A. inserting comments 

    B. previewing results 

    C. adding fonts 

    D. tracking changes 

 

13. A message that appears on screen, usually to tell you something went wrong. 

    A. command 

    B. dialog 

    C. error 

    D. alert 

 

14. One way to clean up files you no longer use is by using: 



    A. Disk Cleanup 

    B. Damp Cleanup 

    C. Dry Cleanup 

    D. Don't Cleanup 

 

15. How do you check hard disk space? 

    A. My PC 

    B. My Computer 

    C. My Desktop 

    D. My Laptop 

 

16. The top directory in a file management system is called a: 

    A. Hierarchy 

    B. Sub-directory 

    C. Root directory 

    D. Folder 

 

17. What is a peripheral device? 

    A. memory 

    B. terminal 

    C. processor 

    D. keyboard 

 

18. 1,024 megabytes is a: 

    A. kilobyte 

    B. gigabyte 

    C. megabyte 

    D. terabyte 

 

19. This toolbar shows the progress of page loading and is useful when you are not sure if the page 

loading is progressing. 

    A. View 

    B. Status 

    C. Address 

    D. Title 

 

20. This network covers a large geographic area, such as a state or country. 

    A. NAN 

    B. MAN 

    C. LAN 

    D. WAN 

 



21. The world's most popular WAN is: 

    A. Internet 

    B. Facebook 

    C. Twitter 

    D. Pandora 

 

22. A reputable Web site or online journal should contain _____ for every article. 

    A. a bibliography or list of references 

    B. the author's name 

    C. a unique URL 

    D. a slideshow 

 

23. What is an option of a web browser? 

    A. Return 

    B. Reply 

    C. Main 

    D. Home 

 

24. The concept of partitioning a physical network to where distinct broadcast domains are created and 

allows access controls between these domains is known as: 

    A. ACLs 

    B. VPNs 

    C. Virtual LANs 

    D. DHCP 

 

25. A printer which includes a scanner and can copy paper documents or send a fax is known as a: 

    A. Dot-Matrix printer 

    B. combined device 

    C. compact printer 

    D. MFD or AIO Device 

 

26. The first step when clearing a paper jam is: 

    A. turn off the printer and unplug the power cable 

    B. open the printer cover 

    C. use a screwdriver to disassemble the printer 

    D. remove the toner cartridge 

 

27. When trying to find help on the local computer's Windows' operating system, the _____ application 

would be the first place to visit. 

    A. Help & Support 

    B. Microsoft Web site 

    C. Office Help 



    D. Internet Explorer 

 

28. As a category, the fastest type of memory on a system is known as: 

    A. cache 

    B. system memory 

    C. EEPROM 

    D. RAM 

 

29. Some printers come with a _____ card preinstalled to allow connections to a wireless local area 

network. 

    A. Toner 

    B. Inkjet 

    C. Silicon 

    D. WLAN 

 

30. The components used to connect computers together so that they can share files and printers is 

called: 

    A. system devices 

    B. web storage 

    C. network devices 

    D. satellites systems 

 

31. In most computer applications, simply pressing _____ on the keyboard will bring up the help menu. 

    A. PrtScn/SysRq 

    B. F11 

    C. F1 

    D. F12 

 

32. Microsoft Word stores the document which opens by default in a template called: 

    A. Bat 

    B. Ini 

    C. Dot 

    D. Doc 

 

33. When using tables in a word processing program, pressing _________ at the end of a row moves the 

insertion point to the first cell in the next row. 

    A. tab 

    B. enter 

    C. spacebar 

    D. ctrl 

 

34. What are bold and italics examples of? 



    A. fonts 

    B. font styles 

    C. font effects 

    D. text effects 

 

35. If you want uniform spacing lines and paragraphs, apply the __________style to the document. 

    A. Sort 

    B. No Spacing 

    C. Line Spacing 

    D. Increase Indent 

 

36. The process of adjusting the spacing between characters in a proportional font to achieve a visually 

pleasing result is known as: 

    A. font 

    B. vertical placement 

    C. orientation 

    D. kerning 

 

37. Which tab contains the tools for inserting and managing footnotes and endnotes? 

    A. Insert 

    B. Page Layout 

    C. Review 

    D. References 

 

38. Which automatic feature causes green wavy lines to appear under words as you type? 

    A. AutoCorrect 

    B. Grammar 

    C. Spelling 

    D. AutoComplete 

 

39. The information imported into the main document to complete a mail merge is called a _____ 

document. 

    A. Mailing 

    B. Data Source 

    C. File 

    D. Destination 

 

40. Pre-formatted documents designed to make creating a document faster and easier is called a: 

    A. Template 

    B. Designer 

    C. Pattern 

    D. Platter 



 

41. An intersection of a column and row is referred to as a/an: 

    A. grid 

    B. active cell 

    C. cell pointer 

    D. cell 

 

42. The following command is used to locate and work with a subset of data in a worksheet. 

    A. filter 

    B. freeze panes 

    C. template 

    D. sort 

 

43. Which of the following is not a data type? 

    A. Currency 

    B. HTML 

    C. Date/Time 

    D. Text 

 

44. In Excel the default print command prints the: 

    A. Selection 

    B. Active sheet 

    C. Range 

    D. Workbook 

 

45. In Excel, to delete the entire column click on the: 

    A. document 

    B. row heading 

    C. column heading 

    D. shortcut button 

 

46. With Microsoft Excel 2007 and above you use the ribbon tab's _____ group to change the font. 

    A. Data 

    B. Formatting 

    C. Font 

    D. Appearance 

 

47. DBMS stands for: 

    A. Database Management System 

    B. Database Marketing System 

    C. Data Board Management System 

    D. Database Management Structure 



 

48. What does descending order displays records do? 

    A. Reverse order 

    B. Top down 

    C. Low to high 

    D. ABC order 

 

49. Which one of the following is not a component of the query Design view? 

    A. field list(s) 

    B. navigation bar 

    C. table pane 

    D. design grid 

 

50. The _____ tool provides the fastest way to create reports because it generates reports immediately. 

    A. chart 

    B. report 

    C. graph 

    D. pivot table 

 

51. When using PowerPoint, to print a handout of all slides with lines for taking notes, use: 

    A. Handouts (1 Slides Per Page) 

    B. Handouts (4 Slides Per Page) 

    C. Handouts (2 Slides Per Page) 

    D. Handouts (3 Slides Per Page) 

 

52. Which software application allows multimedia presentations to be created? 

    A. PowerPoint 

    B. Word 

    C. Access 

    D. Publisher 

 

53. To insert a new slide in Microsoft PowerPoint you can: 

    A. use the keyboard shortcut Ctrl + I + N 

    B. on the insert tab, click the objects group, choose new slide 

    C. on the drawing tab, click the slides group, choose the template for the slide you want 

    D. on the home tab, in the slides group, click the arrow below new slide 

 

54. To create a PowerPoint presentation from a Word outline, click the ____, then click Slides from 

Outline. 

    A. Insert tab 

    B. New Slide list arrow 

    C. Insert Slide list arrow 



    D. Object button 

 

55. To change the fonts throughout a presentation: 

    A. on the view tab in the master views group choose slide master 

    B. use the keyboard shortcut Alt + M + Insert 

    C. on the slides tab in the master group choose view slides 

    D. on the master tab in the view group choose slide master 

 

56. To remove an animation effect use the: 

    A. transitions group or the File menu 

    B. animation pane or the ribbon 

    C. animation ribbon or the transitions pane 

    D. file menu or the master group 

 

57. PowerPoint will support _____ and _____ if you have the appropriate plugins. 

    A. QuickTime(.mov,.mp4), Adobe Flash (.swf) 

    B. FLAC; MPART 

    C. MPEG6 (.mp6); MPEG7(.mp7) 

    D. TAR; ZIP 

 

58. PowerPoint supports _____ to create brochures, pamphlets, fliers, and newsletters. 

    A. AutoCad Files 

    B. templates 

    C. Adobe Indesign 

    D. the Open Presentation Framework 

 

59. Examples of templates in Publisher include all of the following except: 

    A. Sidebars and Pull Quotes 

    B. Brochures 

    C. Newsletters 

    D. Calendars 

 

60. To draw a shape that has both curved and straight segments, choose: 

    A. line 

    B. freeform 

    C. multiline 

    D. draw shape 

 

61. Which type of graphic editing program offers artists and editors the ability to control textures, 

shading, and fine detail? 

    A. podcast 

    B. compressed 



    C. vector 

    D. bitmapped 

 

62. You can crop any picture except _____ by using the crop command. 

    A. animated GIF 

    B. JPG 

    C. PNG 

    D. TIFF 

 

63. When you save a presentation as a PDF: 

    A. each slide becomes a JPG picture 

    B. the document becomes readable but not editable 

    C. each slide becomes a GIF picture 

    D. the entire document becomes one JPG picture 

 

64. If you already have access to the Adobe Creative Suite of products, you can use _____ to create 

embedded video for your presentation. 

    A. Indesign 

    B. Flash 

    C. Photoshop 

    D. Movie Maker 

 

65. If the Web toolbar is not displayed: 

    A. go to customize and choose Web toolbar 

    B. point to toolbars on the view menu and click Web 

    C. point to insert and click toolbars and choose Web 

    D. on the insert group choose Web toolbar 

 

66. Because it is designed as spreadsheet software, sometimes it is easier to create a spreadsheet in 

____ and then insert it into Word. 

    A. Lync 

    B. Excel 

    C. PowerPoint 

    D. Outlook 

 

67. To complete a mail merge, you must connect the document to a: 

    A. Web site 

    B. data source 

    C. e-mail server 

    D. FTP server 

 

68. This allows people to add an emotional tone to online communication. 



    A. animated emotions 

    B. emoticons 

    C. amticons 

    D. emotional faces 

 

69. Include a subject line: 

    A. only when you are writing an official memo 

    B. if the person you are sending it to requires one 

    C. in all e-mail messages 

    D. only in personal names 

 

70. Which situation would be most appropriate to use the "forward" feature of an e-mail program? 

    A. you want to reply to all recipients of an e-mail message 

    B. you want to share a joke you receive on your company e-mail 

    C. you received an e-mail intended for someone else 

    D. you want to reply to an e-mail message 

 

71. Which command do you use to show the differences between an original document and an edited 

copy of the original? 

    A. Changes 

    B. Tracking 

    C. Combine 

    D. Compare 

 

72. When you compare documents, the differences between the two documents are shown as: 

    A. highlighted text 

    B. tracked changes 

    C. bolded text 

    D. comments 

 

73. Which one of the following is not a group on the Review tab? 

    A. Changes 

    B. Collaborate 

    C. Tracking 

    D. Comments 

 

74. When working on a collaborative document, you can tell which author modified sections of the 

document by: 

    A. highlighting text 

    B. writing a Visual Basic script to connect to the SQL data store 

    C. tracking changes 

    D. using the help function 



 

75. Which one of the following applications allows you to share files with people and automatically 

keeps any changes synchronized among all machines? 

    A. Gmail 

    B. Hotmail 

    C. AOL Instant Messenger 

    D. Dropbox 

 

76. _____ is one of several copyright licenses that allows the distribution of copyrighted works. This 

particular license is used when an author wants to give people the right to share, use, and even build 

upon a work they have created. 

    A. BSD License 

    B. GNU 

    C. Creative Commons License 

    D. FSF License 

 

77. This term is used to describe the making of illegal copies of copyrighted software. 

    A. copying 

    B. software piracy 

    C. electronic distribution 

    D. browsing 

 

78. _____ is software that can be used, studied, and modified without restriction, and that can be 

copied and redistributed in modified or unmodified form either without restriction, or with restrictions 

that only ensure that further recipients have the same rights under which it was obtained. 

    A. Collaborative 

    B. Open Source 

    C. Free 

    D. Commercial 

 

79. Scrolling the screen in a chat room is acceptable when: 

    A. it is never acceptable to scroll in the chat screen 

    B. you want to see what people are saying 

    C. you need to get your fellow chatter's attention 

    D. you are bored by the "conversation" and you want to liven things up 

 

80. The technical name for _____ is the copyright infringement of software. 

    A. compiling 

    B. downloading software 

    C. software piracy 

    D. coding 

 



81. The use of someone else's computer resources unless authorized is: 

    A. unethical 

    B. cheating 

    C. ethical 

    D. bully 

 

82. It is acceptable to forward or post an e-mail message that you received if: 

    A. it does not contain any copyrighted material 

    B. the message is typed in all capitals 

    C. the author of the message has given you permission to forward or post it 

    D. the author of the message hasn't marked it as confidential 

 

83. The Golden Rule of Netiquette is: 

    A. never flame a friend 

    B. remember the human 

    C. a smiley in every message 

    D. follow the other rules of netiquette 

 

84. Spamming is very poor Netiquette and means: 

    A. spilling the juice of meat-by products into your keyboard 

    B. posting a message that contains graphics descriptions of something really gross 

    C. posting or e-mailing unsolicited advertising messages to a wide audience 

    D. sending in lines of nonsensical garbage in a chat conversation 

 

85. Texting or SMS would most likely be used in which one of the following situations? 

    A. applying for a job 

    B. update a Web page 

    C. ending a relationship 

    D. a quick update as to your location 

 

86. Gaining access to a computer network, file, or other resource without permission is: 

    A. authorized access 

    B. hacking 

    C. unauthorized use 

    D. interfering 

 

87. A(n) ____ lets administrators and users view the event logs on local or remote machines on the 

Windows NT line of operating systems. 

    A. event parser 

    B. event scanner 

    C. log viewer 

    D. event viewer 



 

88. The _____ is part of an anti-theft system and is a small metal-reinforced hole found on small or 

portable computers or electronics equipment. 

    A. CNR Slot 

    B. PCI Slot 

    C. ISA Slot 

    D. K-Slot 

 

89. One of the most popular virus outbreaks to date, _____ includes a highly specialized malware 

payload that is designed to target only Siemens supervisory control and data acquisition (SCADA) 

systems that are configured to control and monitor specific industrial processes. 

    A. ILOVEYOU 

    B. SCADGONE 

    C. Stuxnet 

    D. SiemensX 

 

90. To avoid being detected by emulation, some viruses rewrite themselves completely each time they 

are to infect new executables. Viruses that utilize this technique are said to be: 

    A. metamorphic 

    B. polymorphic 

    C. static 

    D. diverse 

 

91. In computing, a _____ is a network device that monitors the radio spectrum for the presence of 

unauthorized access points (intrusion detection), and can automatically take countermeasures (intrusion 

prevention). 

    A. WAP 

    B. WPA 

    C. WEP 

    D. WIPS 

 

92. A _____ attack is an attempt to make a machine or network resource unavailable to its intended 

users. 

    A. phishing 

    B. DOS 

    C. crack 

    D. hacking 

 

93. A computer _____ protects against unauthorized use of your equipment. 

    A. lock 

    B. mouse 

    C. drive 



    D. keyboard 

 

94. If your computer is running slow what would be the first step to check? 

    A. hard drive space 

    B. wireless connection 

    C. Internet service 

    D. version of window 

 

95. A(n) _____ can either be software or hardware based and is used to keep a network secure. 

    A. mouse 

    B. firewall 

    C. antipode 

    D. file Lock 

 

96. _____ is the amount of time a device is actually operating as the percentage of total time it should 

be operating. 

    A. Reliability 

    B. Integrity 

    C. Confidentiality 

    D. Availability 

 

97. To modify the margins of a Word document you go to the Page Layout tab and look in the _____ 

group. 

    A. page setup 

    B. paragraph 

    C. themes 

    D. page background 

 

98. To check spelling, use the Spelling & Grammar selection on the ____ group of the Review tab. 

    A. Proofing 

    B. Comments 

    C. Tracking 

    D. Changes 

 

99. In Word what function key launches the spelling and grammar check? 

    A. F0 

    B. F9 

    C. F7 

    D. F8 

 

100. If there is a word which your word processing program does not recognize which you use often, 

you can: 



    A. check grammar 

    B. convert the thesaurus 

    C. use shift+ F7 to ignore 

    D. add it to the dictionary 
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